CleanMyMac 3
User Guide
# CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview</td>
<td>4</td>
</tr>
<tr>
<td>About CleanMyMac 3</td>
<td>4</td>
</tr>
<tr>
<td>What’s New?</td>
<td>4</td>
</tr>
<tr>
<td>System Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Download and Installation</td>
<td>5</td>
</tr>
<tr>
<td>CleanMyMac 3 Activation</td>
<td>6</td>
</tr>
<tr>
<td>Basics</td>
<td>8</td>
</tr>
<tr>
<td>Starting Cleaning Modules</td>
<td>8</td>
</tr>
<tr>
<td>Using CleanMyMac Utilities</td>
<td>8</td>
</tr>
<tr>
<td>Checking Mac’s Statuses on the Dashboard</td>
<td>9</td>
</tr>
<tr>
<td>Monitoring Mac’s Health with CleanMyMac 3 Menu</td>
<td>9</td>
</tr>
<tr>
<td>Starting a Scan</td>
<td>10</td>
</tr>
<tr>
<td>Discontinuing a Task</td>
<td>10</td>
</tr>
<tr>
<td>Using Quick Cleanup and Smart Selection</td>
<td>10</td>
</tr>
<tr>
<td>Modifying a Cleanup List</td>
<td>11</td>
</tr>
<tr>
<td>Starting a Cleanup</td>
<td>12</td>
</tr>
<tr>
<td>Viewing Cleanup Results</td>
<td>13</td>
</tr>
<tr>
<td>Cleaning Modules</td>
<td>14</td>
</tr>
<tr>
<td>Smart Cleanup</td>
<td>14</td>
</tr>
<tr>
<td>System Junk</td>
<td>16</td>
</tr>
<tr>
<td>Photo Junk</td>
<td>19</td>
</tr>
<tr>
<td>Mail Attachments</td>
<td>22</td>
</tr>
<tr>
<td>iTunes Junk</td>
<td>23</td>
</tr>
<tr>
<td>Trash Bins</td>
<td>25</td>
</tr>
<tr>
<td>Large &amp; Old Files</td>
<td>27</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Maintenance Utilities</td>
<td>30</td>
</tr>
<tr>
<td>Uninstaller</td>
<td>30</td>
</tr>
<tr>
<td>Maintenance</td>
<td>32</td>
</tr>
<tr>
<td>Privacy</td>
<td>36</td>
</tr>
<tr>
<td>Extensions</td>
<td>38</td>
</tr>
<tr>
<td>Shredder</td>
<td>41</td>
</tr>
<tr>
<td>Dashboard</td>
<td>42</td>
</tr>
<tr>
<td>CleanMyMac 3 Menu</td>
<td>46</td>
</tr>
<tr>
<td>Preferences</td>
<td>49</td>
</tr>
<tr>
<td>General Tab</td>
<td>49</td>
</tr>
<tr>
<td>Smart Cleanup Tab</td>
<td>50</td>
</tr>
<tr>
<td>Scheduler Tab</td>
<td>50</td>
</tr>
<tr>
<td>CleanMyMac 3 Menu Tab</td>
<td>51</td>
</tr>
<tr>
<td>Updates Tab</td>
<td>51</td>
</tr>
<tr>
<td>Privacy Tab</td>
<td>52</td>
</tr>
<tr>
<td>Ignore List Tab</td>
<td>52</td>
</tr>
</tbody>
</table>
Overview

About CleanMyMac 3

CleanMyMac 3 is a next evolutionary step of a cleaning app chosen by millions of Mac users. Beautifully designed, it has become far more than just a cleaning utility. Not only CleanMyMac removes gigabytes of junk but also monitors and optimizes Mac’s performance and health.

New cleaning modules provide advanced options for accurate reclaim of your disk space while a set of diverse utilities manages issues with Mac’s health, monitoring, system maintenance, private data, uninstallation of apps, and many more.

What’s New?

- **Photo Junk module**, which removes supporting Photos files and replaces heavy RAW originals with high-quality JPEGs.
- **Mail Attachments module**, which removes locally stored copies of downloads and attachments.
- **iTunes Junk module**, which removes outdated device backups, broken downloads, old iOS software updates, and copies of iOS apps stored locally.
- **Maintenance module**, which lets users run a myriad of optimization tasks.
- **Privacy module**, which cleans up chat, browsing and download history, cookies, recent items list and more.
- **Dashboard**, which shows Mac performance in real time and provides the RAM cleanup feature.
- **CleanMyMac 3 Menu**, which gives users access to multiple CleanMyMac 3 tools without launching the application itself.
- **Health Alerts**, which help diagnose hardware and process issues.

Localized into: English, Deutsch, Français, Italiano, Nederlands, Español, Português do Brasil, 繁体中文, 日本語, Polski, Русский, Українська.

System Requirements

- macOS 10.9 or higher (starting from CleanMyMac 3.8.5)
- macOS 10.8 to 10.12 (up to CleanMyMac 3.8.4)
- 56.8 MB of free disk space
- Intel Macs only
Download and Installation

1. Download CleanMyMac 3 or visit the MacPaw website.

2. Double-click on the downloaded CleanMyMac.dmg file and proceed with the installation. Drag the CleanMyMac 3 icon to your Applications folder to complete the installation.

3. Open CleanMyMac 3 by doing any of the following:
   - Double-click the CleanMyMac 3 icon in the Applications folder.
   - Click the Launchpad icon in the Dock and then click the CleanMyMac 3 icon in Launchpad.
   - Enter the application name in Spotlight.

**NOTE**
If you want CleanMyMac 3 to stay in your Dock permanently, control-click the CleanMyMac icon in the Dock and choose Options → Keep in Dock.
CleanMyMac 3 Activation

Activation is a simple procedure that unlocks a full version of CleanMyMac 3 and grants you unlimited access to all advanced cleaning and utility modules. To complete the activation, you need to purchase a CleanMyMac 3 license and enter its unique activation number in the License Activation dialog.

A trial version of CleanMyMac 3 has some limitations, but its free features still can be rather helpful to you:

**Free trial features**

- **RAM cleanup**: Frees up memory as many times as you need through CleanMyMac 3 Menu or Dashboard.
- **Shredder**: Erases any number of files in a secure or ordinary way.
- **CleanMyMac 3 Menu**: Shows system statuses, health updates, and frees up RAM.

**Limitations of the trial version**

- **Cleaning modules**: Removes no more than 500 MB of unneeded items across all cleaning modules (including Move to Folder operations).
- **Utilities modules**: Provides only basic utilities functionality and runs a limited number of scripts.
- **CleanMyMac 3 Menu**: Allows you to empty the Trash folder only via CleanMyMac’s Trash Bins module (please mind the general cleaning modules limitation of 500 MB of processed data). A licensed copy will empty it directly from the CleanMyMac 3 Menu.

**Complete the online activation**

**NOTE**

You’ll need Internet access to complete the activation.

1. Open CleanMyMac 3.
2. Click the Unlock Full Version (or Upgrade at 50% OFF) button in the upper left corner of the window.
3. Choose the appropriate option in the License Activation dialog:
   - Enter Activation Number – if you already have a license.
   - Buy License (or Upgrade at 50% OFF) – if you do not have a license.
4. Enter your activation number in the License Activation dialog.
If you entered an activation number correctly, CleanMyMac unlocks its full functionality automatically. Alternatively, you can click Activate.

**NOTE**

A single license of CleanMyMac 3 is valid for one Mac and works on all of its user accounts.

**Activate a box version of CleanMyMac 3**

If you purchased a box version of CleanMyMac 3, you will be automatically presented with an activation dialog on the first launch. You will need to provide your details and accept the license agreement. This will serve as a confirmation of your purchase later on.

**Reset the license to apply it on another Mac**

If you want to use your CleanMyMac license on another Mac, you need to cancel the current activation first:

1. Choose CleanMyMac 3 → Activation Info.
2. Click Deactivate License in the Activation Info dialog.
3. Click Disable License in the confirmation dialog that appears.

When the license is disabled, activate it as described in the previous section.

**Retrieve your lost license**

If you can’t find your activation number, we can send it to you by email. Just do the following to get your activation number:

1. Choose Activate → Retrieve License. You’ll be redirected to the License Retrieval page on CleanMyMac’s website.
2. On the License Retrieval page, enter your name or email address and click Retrieve.
3. If you have more than one MacPaw product license, you’ll need to select the license for retrieval. Click “send email” next to the appropriate license.

You’ll receive an email with the license in a couple of minutes.

**NOTE**

Should you experience any difficulties, please contact our [Customer Support](mailto:).
Basics

Starting Cleaning Modules

As you open CleanMyMac 3, the first thing you see is a Smart Cleanup welcome screen.

Using CleanMyMac Utilities

CleanMyMac 3 provides tools that improve your Mac’s performance, uninstall apps correctly, care about keeping your privacy, and many more.
Checking Mac's Statuses on the Dashboard

CleanMyMac's Dashboard shows state infographics of your Mac in real time and provides the RAM cleanup feature. You can reach it from any module.

Monitoring Mac's Health with CleanMyMac 3 Menu

CleanMyMac 3 Menu monitors the system, alerts of health issues, and keeps most useful CleanMyMac's features at hand.
Starting a Scan

Switch to a module you would like to use and do one of the following:
- Click Scan at the bottom of the window.
- Choose Action → Scan.
- Press Return.

Discontinuing a Task

Do any of the following:
- Click Stop at the bottom of the window.
- Press Return.

**NOTE**

If you start a maintenance task, you will not be able to discontinue it.

Using Quick Cleanup and Smart Selection

When a cleaning module completes scanning, you see a results preview screen:

![Image of CleanMyMac scan results](image)

While scanning your Mac, CleanMyMac 3 selects only those files that are absolutely safe for removal: unneeded, outdated or broken files that were created automatically. This approach is called Smart Selection.
CleanMyMac smart-selects different item types for each module:

<table>
<thead>
<tr>
<th>Module</th>
<th>Types of items that are smart-selected for removal</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Junk</td>
<td>All types of items, except for the following:</td>
</tr>
<tr>
<td></td>
<td><strong>Leftovers</strong> of applications;</td>
</tr>
<tr>
<td></td>
<td>Some Xcode Junk files (present on a developer’s Mac only): module cache files and archives;</td>
</tr>
<tr>
<td></td>
<td><strong>Document Versions</strong>: the earliest and latest version of your document. CleanMyMac automatically selects only those versions that were made with less than 4-hour interval, keeping the latest one in the range.</td>
</tr>
<tr>
<td>Photos Junk</td>
<td>In a Photos library: Faces cache files and Photos cache files. In an iPhoto library: Originals of fixed red-eye and rotated photos as well as originals of images combining these changes.</td>
</tr>
<tr>
<td>Mail Attachments</td>
<td>All types of items, except user-modified items (stored in Mail Downloads).</td>
</tr>
<tr>
<td>iTunes Junk</td>
<td>All types of items, except the following:</td>
</tr>
<tr>
<td></td>
<td>iOS apps;</td>
</tr>
<tr>
<td></td>
<td>The most recent iOS backup for each app.</td>
</tr>
<tr>
<td>Trash Bins</td>
<td>All types of items.</td>
</tr>
<tr>
<td>Large &amp; Old Files</td>
<td>None. You need to check scan results and select files for removal by yourself.</td>
</tr>
</tbody>
</table>

CleanMyMac establishes accuracy and safety of cleanup operations by means of its constantly updated Safety Database and your personal Ignore List.

**Modifying a Cleanup List**

If you do not agree with the Smart Selection choice and want prevent removal of some items, exclude them from the cleanup list:

  - Click Deselect All to exclude all found items from the cleanup list.
  - Deselect a checkbox to exclude an item or category from the cleanup list.
NOTE
When you manually deselect some items from the cleanup list, CleanMyMac 3 remembers your choice and keeps these items deselected in future scan results. However, if you simply click Deselect All, CleanMyMac does not remember this choice.

If you want to remove some items that are not smart-selected, add them to the cleanup list by doing any of the following:

Select a checkbox next to an appropriate item or category.
Click Select All to add all found items from the cleanup list. This button appears when no item is selected.

Starting a Cleanup

Remove selected files and free up disk space by doing any of the following:

Click Clean at the bottom of the window.
Choose Action → Clean.
Press Return.

NOTE
The first time you start cleanup or maintenance, the system may ask for permission to install CleanMyMac’s Helper Tool. All you need to do is enter your administrator account password (the one you use to log into your Mac). Don’t worry, the installation of a helper is a safe and common procedure provided by macOS. [Learn more about it in our Knowledge Base]
**NOTE**

If the View Log button is highlighted yellow, the cleanup has been completed with errors. Click the button to check what went wrong.
Cleaning Modules

Smart Cleanup

What does this module do?
Smart Cleanup is an essential CleanMyMac 3 module that incorporates capabilities of all cleaning modules. For that reason, using Smart Cleanup once in a while is enough for keeping up your Mac clean and healthy on a basic level.

Where did your Mac get this junk?
Each of the included modules searches specific types of junk files, in particular:

- **System Junk**: outdated cache files, old logs and update files, extra application binaries, broken application data, unused language and localization files.
- **Photo Junk**: Photos cache files, Faces cache files, RAW originals of photos, local copies of iCloud Library images.
- **Mail Attachments**: local copies of attached files that you’ve once opened or viewed in Mail.
- **iTunes Junk**: iOS apps stored on Mac, old iOS device backups and update files, corrupt and incomplete downloads.
- **Trash Bins**: deleted items in trash folders on your Mac and external drives, as well as in the Photos and Mail applications.
- **Large & Old Files**: a list of files from your system that you may want to delete. Files in this module are not smart-selected for removal. You must do it by yourself.

To find out more about the source of the junk on your Mac, read information in the corresponding module.

What does CleanMyMac smart-select in this module?
Smart Cleanup automatically adds to the removal list only those items that neither affect functionality of your Mac nor belong to your personal files. All types of files smart-selected for removal are listed in [Using Quick Cleanup and Smart Selection](#).

**NOTE**
You can exclude some modules or submodules from the Smart Cleanup scan list by changing [CleanMyMac’s Preferences](#).
After completion of a full scan, you see this screen:

Find out more about items smart-selected for removal
Do any of the following:

- Click on a module icon and read information in the message that appears. If available, click See Details.
- Switch to the appropriate module in the Modules list and read the description.
- Check results in modules with the Needs Review status.

Modify the cleanup list

- Exclude a cleaning module from the cleanup list: Deselect the checkbox under the module icon.
- Exclude some items of a particular module from the cleanup list: Switch to the appropriate module in the Modules list, and then deselect checkboxes of items you do not want to remove.

See also

- Changing Smart Cleanup scan list
- Adding files to the Ignore List
- Using Quick Cleanup and Smart Selection
System Junk

What does this module do?
System Junk takes care of all unneeded data generated by your system and applications. It accurately analyzes all your files and selects for removal only outdated cache files, old logs, extra application binaries, broken application data, unused language and localization files.

What does CleanMyMac smart-select in this module?
CleanMyMac smart-selects for removal all types of items found in System Junk, except Leftovers and the Module Cache folder in Xcode Derived Data.

System Junk items | Where does your Mac get this junk?
--- | ---
Broken Login Items | When you remove an application or a service, a broken link to it may remain among your Login Items. CleanMyMac easily removes those links.
Broken Preferences | Sometimes application preference files get corrupted, which leads to improper behavior or inability to launch applications. Generally, removing broken preference files eliminates these negative effects.
Development Junk | During installation and configuration process, applications may create some supporting files that become useless afterwards.
Document Versions | Many apps save versions of a document so that you could restore its earlier versions. It happens automatically, as you work on a doc, or manually, when you command to save changes. The feature is useful but you may be surprised to discover that copies of your documents occupy gigabytes of space.
By default, CleanMyMac never offers to remove the earliest and latest version of your doc. It automatically selects only those versions that were made with less than 4-hour interval, keeping the latest one in the range.
iOS Photo Cache | After you sync photos with any of your iOS devices, some photos stay cached on your Mac. This data only wastes space after the sync is done.
Language Files | Almost every application comes with multiple localizations you do not use. You can safely remove them to save a significant amount of disk space.
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leftovers</td>
<td>Uninstalled applications sometimes leave a lot of junk that occupies space on your Mac but brings no value. CleanMyMac doesn’t offer these files for removal by default, so you need to select them manually.</td>
</tr>
<tr>
<td>macOS Localizations</td>
<td>Your Mac’s operating system includes dozens of languages files, most of which you’ll never use. CleanMyMac deletes unneeded language files to save your space.</td>
</tr>
<tr>
<td>Old Updates</td>
<td>Some applications don’t clean old versions of their updates. Therefore, these outdated files may take up a lot of space on your Mac. Removing old application updates is safe.</td>
</tr>
<tr>
<td>System Cache Files</td>
<td>System applications generate and keep a lot of cache files, which after a while result in longer startup time, performance degradation, and possible improper system functioning. CleanMyMac cleans cache and improves performance.</td>
</tr>
<tr>
<td>System Log Files</td>
<td>Activity of your system applications and services is being logged into numerous files. Generally, they are useful for debugging purposes only, and therefore are hardly worth employing your disk space.</td>
</tr>
<tr>
<td>Universal Binaries</td>
<td>Developers usually compile their applications to support several Mac architectures, which means putting in twice and sometimes four times the code. However, your Mac only needs one copy.</td>
</tr>
<tr>
<td>User Cache Files</td>
<td>Originally intended to improve startup time, the cache files of your applications ultimately accumulate, which results in improper system functioning or overall performance drop.</td>
</tr>
<tr>
<td>User Log Files</td>
<td>The activity of your applications is being logged into numerous files, which start using a lot of space after a while. However, these files are rarely used and useless if old.</td>
</tr>
<tr>
<td>Xcode Junk</td>
<td>If you are a developer, you might want to clean up your system from a significant amount of intermediate build information and project index generated by Xcode. This CleanMyMac ability will come in useful when you need to free some space. Note that CleanMyMac doesn’t remove Module Cache and Archives automatically.</td>
</tr>
</tbody>
</table>

**NOTE**

You can exclude some of the System Junk submodules from the scanning process. Go to CleanMyMac 3 → Preferences → Smart Cleanup tab and deselect the checkboxes of
submodules you don’t want to be scanned. Note that your choice also affects the Smart Cleanup module. For more information, read Smart Cleanup tab.

Take a closer look at found items and change their sorting
After you open a detailed results screen, you can do any of the following:

- **Reveal files included to a particular category:** Click the appropriate category. Items included to a category are displayed in the right-side pane.

- **View an item in the Finder:** Hover over an item you want to open in the Finder and click a magnifier icon next to it.

- **View an item path:** Hover over an item line. Double-click a path component to open a corresponding directory in the Finder. If an item path does not appear, choose View → Show File Path.

- **Change sorting:** Choose appropriate options from “Sort by” pop-up menus to change sorting of categories and items.

- **Find an item within scan results:** Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

- **Reset scan results:** If you want to discard current scan results and start a new scan quickly, choose Action → Rescan. Note that your current scan results won’t be saved.

See also

- Adding files to the Ignore List
Photo Junk

What does this module do?
The Photo Junk module processes both Photos and iPhoto libraries to find data that can be safely removed.

What does CleanMyMac smart-select in this module?
For a Photos library:
CleanMyMac smart-selects Photos cache files and Faces cache files. They are recovered automatically when needed.

For an iPhoto library:
CleanMyMac smart-selects originals of fixed red-eye and rotated photos, since their data is restorable. It does not offer you to remove final versions of your images.

Choose a library to scan
You can do any of the following:

Make no changes: Use a default library for scanning, if selected.

Choose a new library: Click Change Library, and then locate to the library you want to analyze. Click Open.

Open the added library in the Finder: Click a magnifier icon next to the library.

Photos library

In a Photos library, CleanMyMac is looking for the following data:

RAW images
(not supported on macOS 10.13 and later)
Initially, most photos are saved as RAW files, which are not usable in common image viewers and editors. That’s why, when you import a RAW file to Photos, it always creates a JPEG copy that you actually view within the application.

CleanMyMac finds and replaces RAW originals of photos with their high-quality JPEGs, and thus saves a lot of space.

Faces cache
While you work with Faces, multiple supporting files are created. These files are fully recoverable, and their removal does not affect your experience in Photos.
Photos cache: Photos creates several types of cache files that are absolutely safe to remove. Every time you launch Photos, they get regenerated automatically.

iCloud local copies: When you open iCloud via the Photos app, copies of all images you’ve viewed get stored on your Mac. CleanMyMac removes only these local copies and does no harm to originals.

However, files of this type are not selected for removal by default because next time, you’ll need an Internet connection to view these images in Photos.

Review scan results for a Photos library (not supported on macOS 10.13 and later)

After you open a detailed results screen, you can do the following:

- **Zoom images in and out**: Drag the slider in the upper right corner to scale images.
- **View image in Photos**: Control-click an image and choose Reveal in Photos from the shortcut menu.
- **Compare original RAW and JPEG images**: Control-click an image and choose Quick Look from the shortcut menu to view images side-by-side.

Sort found items: Choose an appropriate option from the “Sort by” pop-up menu to change the sorting criterion.
Find an image within scan results: Start typing an image title in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

Reset scan results: If you want to discard current scan results and start a new scan quickly, choose Action → Rescan. Note that your current scan results won’t be saved.

iPhoto library

In an iPhoto library, CleanMyMac is looking for hidden originals of previously edited images (rotated, cropped, or edited in any other way).

Review scan results for an iPhoto library

After completion of an iPhoto library scan, you can do the following on the detailed results screen:

View an image in iPhoto: Control-click an image and choose Reveal in iPhoto from the shortcut menu.

Compare original and final-version images: Control-click an image and choose Quick Look from the shortcut menu to view images side-by-side.

Review images within a particular group: Click the group.

Regroup images: Click the “Group by” pop-up menu above the listed photo groups and choose a grouping criterion:

Modifiers — based on changes applied to images.

Events — based on event names in iPhoto.

Date — based on image creation date.

NOTE

If you are a photographer and RAW files are valuable for you, try CleanMyMac’s “Ignore RAW photos” feature to exclude this kind of images from scan results. Choose CleanMyMac 3 → Preferences. On the Ignore List tab, switch to the iPhoto Junk section, and then select “Ignore RAW photos” checkbox.

See also

[Adding files to the Ignore List](#)

[Using Quick Cleanup and Smart Selection](#)
Mail Attachments

What does this module do?
The Mail Attachments module scans Mail for restorable locally kept downloads and attachments. It reclaims a lot of free space while keeping original attachments safe in your online Inbox.

Where did your Mac get this junk?
When you open or view a new attachment in Mail, the application stores its copy on your disk and keeps it until you delete the associated email.

After a while, a total number of duplicated attachments may reach a couple of gigabytes and more, especially if you receive many images, PDF or presentation files.

What does CleanMyMac smart-select in this module?
CleanMyMac smart-selects for removal only those attachments that can be easily brought back by simply accessing related emails in Mail. If you have made some changes to your attachments, CleanMyMac does not select them for removal.

Review found items and change their sorting
If some of the attachments and downloaded documents differ from the original attachments stored in your online mailbox, Mail Attachments marks them as User-Modified.

After you open a detailed results screen, you can do any of the following:

- **View an attachment in the Finder:** Hover over an item you want to reveal and click a magnifier icon next to it.

- **View an attachment with Quick Look:** Hover over a file you want to reveal and click a Quick Look icon next to it.

- **Regroup attachments:** Choose an appropriate grouping criterion (an access date or file kind) from the “Group by” pop-up menu.

- **Sort attachments by a mail account:** Choose an appropriate mail account from the pop-up menu in the upper right corner.

- **Change a sorting criterion of attachments:** Choose an appropriate sorting criterion from the “Sort by” pop-up menu.

- **Find an item within scan results:** Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

- **Reset scan results:** If you want to discard current scan results and start a new scan quickly, choose Action → Rescan. Note that your current scan results won’t be saved.
iTunes Junk

What does this module do?
iTunes Junk cleans up outdated device backups, broken downloads, old iOS software updates, and copies of iOS apps stored locally in iTunes.

What does CleanMyMac smart-select in this module?
CleanMyMac smart-selects for removal all types of items found in iTunes Junk, except iOS apps and the most recent iOS backup for each app.

<table>
<thead>
<tr>
<th>iTunes Junk items</th>
<th>Where did your Mac get this junk?</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS Applications</td>
<td>When you download iOS apps to your iPhones or iPads, iTunes saves backups of these downloads on Mac. Removing these files from iTunes won’t affect your devices. Consider keeping the old copies of iOS apps in case you’re planning on using old iOS devices further and syncing these apps to them.</td>
</tr>
<tr>
<td>iOS Device Backups</td>
<td>All your iOS device backups are stored on Mac. However, information on your devices is changing constantly, and backups get quickly outdated. You can easily get rid of old backups without losing any valuable data. The latest backup is never selected for removal automatically.</td>
</tr>
<tr>
<td>iOS Software Updates</td>
<td>Every time you update your iOS devices via cable sync, multiple update files remain on your Mac and increase the amount of wasted space on your disk. Removing these files will do no harm to iOS devices or Mac.</td>
</tr>
<tr>
<td>iTunes Broken Downloads</td>
<td>Due to a number of reasons, your Mac may store a collection of files with incomplete data. These may be broken podcasts, movies, audios, etc. Removing these files is safe.</td>
</tr>
<tr>
<td>iTunes Cache</td>
<td>Every time you listen to music in iTunes, it caches album artworks to reach them faster next time. The folder storing these artworks may take up gigabytes of space. Moreover, when you listen to Apple Music streams, your Mac gets stuck with growing number of artwork cache files. Removing artwork cache files is absolutely safe because they are recreated next time you are listening to music.</td>
</tr>
</tbody>
</table>
NOTE
You can exclude some of the iTunes Junk submodules from the scanning process. Go to CleanMyMac 3 → Preferences → Smart Cleanup tab and deselect the checkboxes of submodules you don’t want to be scanned. Note that your choice also affects the Smart Cleanup module. For more information, read Smart Cleanup Tab.

Take a closer look at found items and change their sorting
After you open a detailed results screen, you can do any of the following:

View an item in the Finder: Hover over an item you want to reveal and click a magnifier icon next to it.

View an item with Quick Look: Hover over a file you want to reveal and click a Quick Look icon next to it.

Change a sorting criterion of items: Choose an appropriate sorting criterion from the “Sort by” pop-up menu.

Find an item within scan results: Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

Reset scan results: If you want to discard current scan results and start a new scan quickly, choose Action → Rescan. Note that your current scan results won’t be saved.

See also
- Adding files to the Ignore List
- Using Quick Cleanup and Smart Selection
Trash Bins

What does this module do?
Apart from the ordinary startup drive Trash, Macs generally have additional application trash folders, for example, Mail Trash. Each disk partition and external drive also has its own hidden trash folder where previously deleted items reside.

Where did your Mac get this junk?
The Trash Bins module scans multiple folders where your Mac and your applications store files you have once removed:

- **Local Mail Trash**, which contains emails deleted in the Mail application.
- **Aperture Trash**, which contains images deleted in Aperture.
- **iPhoto Trash**, which contains images deleted in iPhoto.
- **Photos Trash**, which contains images deleted in Photos.
- **Gemini Duplicates**, which contains duplicated images that you have earlier removed from a Photos library using [Gemini](#).
- **Startup Drive Trash**, which contains items deleted from the main disk and items removed from iCloud.
- **External Drive Trash**, which contains items deleted from external drives (a number of such trash folders equals a number of external drives).

What does CleanMyMac smart-select in this module?
CleanMyMac adds all trashed items to the cleanup list automatically, except for Gemini Duplicates, which can be removed via the Photos app only. Also, starting from macOS 10.13, Photos Trash can be removed via the Photos app only. Please find the detailed instructions on the next page.

Take a closer look at found items and change their sorting
After you open a detailed results screen, you can do any of the following:

- **Reveal files from a particular location**: Click the location. Items included to the location are revealed in the right-side pane. To view contents of a folder in the right-side pane, click its disclosure triangle.
- **View an item in the Finder**: Hover over an item you want to reveal and click a magnifier icon next to it.
- **View an item path**: Hover over an item line. Double-click a path component to open a corresponding directory in the Finder. If an item path does not appear, choose View → Show File Path.
Change sorting of items or locations: Choose appropriate options from "Sort by" pop-up menus to change sorting of locations and items.

Find an item within scan results: Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

Reset scan results: If you want to discard current scan results and start a new scan quickly, choose Action → Rescan. Note that your current scan results won’t be saved.

Clean up your Mac from trash
You can simply click Empty on the summary screen or choose a removal option from the pop-up menu next to the Empty button on the detailed results screen:

Remove Immediately: This is a default option and it removes files in an ordinary way.

Remove Securely: This option deletes items so that they cannot be recovered with any special tools. This type of removal takes more time, but all data gets rewritten, which leaves no chance to recover.

NOTE
Despite the fact that the Secure Empty Trash feature is missing in macOS El Capitan (10.11 and higher), CleanMyMac still effectively removes your data in a secure way.

Remove Gemini Duplicates (only for the Gemini app users): Open Photos and navigate to the Gemini Duplicates album. Then, select and control-click all contents of the album. From the shortcut menu, choose Delete Photos/Videos.

Remove Photos Trash
Starting from macOS 10.13, Photos files can be removed via Photos app only. If you have an earlier version of macOS, CleanMyMac easily removes these files without additional actions.

So, to delete Photos library trash on macOS 10.13 and later, open Photos and navigate to the Recently Deleted album. Then, click Delete All in the upper right corner of the Photos window.

See also
- [Adding files to the Ignore List](#)
- [Using Quick Cleanup and Smart Selection](#)
Large & Old Files

What does this module do?
The Large & Old Files module brings large and old files to the surface and allows you to sort them by size, type, and date last opened. Therefore, you can easily select and remove files you don’t need.

Where did your Mac get this junk?
By default, CleanMyMac scan your Home folder but you can select any other one. Scan results reveal files and folders occupying at least 50MB of disk space.

What does CleanMyMac smart-select in this module?
CleanMyMac does not smart-select any files in this module. You must do it by yourself.

Select a location you want to analyze
You can do any of the following:

- **Select a new location for scanning**: Click Add Folder and navigate to the location you want to analyze. It can be an internal or external drive, network folder or any other location.
- **Remove a location from the scan list**: Click Close (x) next to the location you do not want to scan.
- **Remove all locations from the scan list**: Click Clear List.
- **Make no changes** and use a default Home folder for scanning.

Take a closer look at found items and change their sorting
After you open a detailed results screen, you can do any of the following:

- **View files included to a particular group**: Click the group. Items included to the group are revealed in the right-side pane. To view contents of a folder in the right-side pane, click its disclosure triangle.
- **View a file in the Finder**: Hover over an item you want to reveal and click a magnifier icon next to it.
- **View a file with Quick Look**: Hover over a file you want to reveal and click a Quick Look icon next to it.
- **Regroup files**: Choose an appropriate grouping criterion from the “Group by” pop-up menu.
- **Change a sorting criterion of attachments**: Choose an appropriate option from the “Sort by” pop-up menu.
Find an item within scan results: Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

Pay attention that some files have special icons next to their paths. These icons indicate origin of the file, which can be of the following type:

This is a Photos file that is stored in iCloud and cannot be previewed in CleanMyMac. However, you can click a magnifier icon to download the file from iCloud and open it in Photos. If you select this file for removal, it will be removed from both iCloud and local Photos library.

This is a Photos file from some of your local libraries. You can preview it as described above. Please note that starting from macOS 10.13, this kind of files can be removed via the Photos app only. You can find the detailed instructions on the next page.

This is an iTunes file from some of your local libraries. You can preview it as described above.

Reset scan results: If you want to discard current scan results and start a new scan quickly, choose Action → Rescan. Note that your current scan results and the list of selected items won’t be saved.

Move or remove files
CleanMyMac gives you several options of what to do with the selected files. Click the pop-up menu next to the Remove/Move button and make your choice:

Move to Trash: Moves files to your system Trash folder.

Move files to another folder: Moves files to a folder of your choice. When you click this option, CleanMyMac opens a dialog where you can locate a destination folder. After you have selected a folder, the pop-up menu changes its name to “Move to <folder name>” and preserves it until another folder is selected, or until CleanMyMac is relaunched.

Remove Securely: This option deletes items so that they cannot be recovered with any special tools. This type of removal takes more time, but all data gets rewritten, which leaves no chance to recover.

NOTE
Despite the fact that the Secure Empty Trash feature is missing in macOS El Capitan (10.11 and higher), CleanMyMac still effectively removes your data in a secure way.
**Remove Immediately:** This is a default option and it removes files quickly, in an ordinary way.

---

**Remove Photos files**

Starting from macOS 10.13, Photos files can be removed via Photos app only. If you have an earlier version of macOS, CleanMyMac easily removes these files without additional actions.

So, to delete large and old Photos files on macOS 10.13 and later, do the following:

1. Find items you’d like to remove in CleanMyMac’s Large & Old Files and select them.
2. Click Remove.
3. Open Photos and navigate to the Large Media to Delete album.
4. Select all contents of the album.
5. Control-click any selected item and choose Delete Photos/Videos from the shortcut menu.

Now, your Photos library is clean.
Maintenance Utilities

Uninstaller

What can you do with this utility?
Uninstaller shows you all custom applications available on your Mac, including those that aren’t stored in the Applications folder (for example, Steam games).

With Uninstaller, you can:

- **Remove applications and application suites with all related files.** Application suites are applications grouped by Uninstaller in a single folder based on the facts that they were installed together and share resources (for example, MS Office or Adobe applications).
- **Reset an application to the initial state** to resolve some troubles or to make it run faster.
- **View unsupported applications** — Uninstaller marks these applications with the “Unsupported” status under the application name.
- **View and reset system applications.**

What does CleanMyMac smart-select in this module?
By default, Uninstaller does not offer you to remove anything. You must decide on each application and choose what you would like to do with it.

**NOTE**
Uninstaller doesn’t support removal of obligatory system applications and adds them to CleanMyMac’s Ignore List by default.

To make system applications visible in Uninstaller, do the following:
1. Go to CleanMyMac 3 → Preferences → Ignore List → Uninstaller.
2. Deselect the Ignore system applications checkbox.

View applications installed on your Mac
After you open a main Uninstaller screen, you can do any of the following:

- **View a complete list of files associated with an application:** Click an application. All items associated with the application are revealed in the right-side pane. If you click an application suite, a list of all applications within it are displayed in the Binaries groups in the right-side pane.
- **View an item in the Finder:** Hover over an item you want to reveal and click a magnifier icon next to it.
Change the way applications are sorted: Choose an appropriate option from the “Sort by” pop-up menu.

Find an item in Uninstaller: Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

NOTE
If you selected for removal an entire application suite, Uninstaller will remove all applications within this suite.

Select applications for complete uninstallation
You can select an application for complete uninstallation by any of the following methods:

Select a checkbox next to an application you no longer need, and CleanMyMac will automatically add it to the uninstallation list.

If you have previously selected the application for reset, click the application in the applications list, and then click Complete Uninstallation in the Smart Selector block.

Drag one or multiple applications (.app files) either directly to the CleanMyMac Dock icon or to the open CleanMyMac window.

NOTE
Uninstaller does not support removal of system applications due to macOS restrictions. However, you can reset them.

Select applications for reset: Select a checkbox opposite the application you want to reset, and then click Application Reset in the Smart Selector block. This option smart-selects items that must be removed to reset the application to its initial state. After the reset is completed, the application starts working with a clean state when you launch it next time.

Uninstall/reset the selected applications
Depending on files and applications selected for removal, the main CleanMyMac button changes its state to one of the following:

Uninstall: Click this button to remove all selected applications leaving no leftovers.

Reset: Click this button to bring the selected applications to initial state.

Remove: Click this button to uninstall and/or reset selected applications and remove files of your choice.
Maintenance

What can you do with this utility?
The Maintenance module provides essential scripts and procedures that will keep your Mac up and running for a long time. In particular, using this CleanMyMac’s module, you can optimize system performance, resolve various errors, and increase search speed.

CleanMyMac’s Maintenance includes the following tasks:

- Run Maintenance Scripts
- Repair Disk Permissions
- Verify Startup Disk
- Speed Up Mail
- Rebuild Launch Services Database
- Reindex Spotlight
- Flush DNS Cache

Start a maintenance task
Click View All Tasks on the Maintenance start screen to open a main screen. Choose an appropriate task and click Run.

Please carefully read and follow the recommendations below to prevent system lag under high workloads. Also note that all of the tasks have different usage recommendations, and it is not necessary to run them all at once.

Run Maintenance Scripts
Maintenance scripts are basic system routines that macOS runs on daily, weekly and monthly basis. These scripts are aimed to keep your Mac in shape.

CleanMyMac unifies these valuable scripts in a single task that includes, but is not limited to the following procedures:

- Deletion of temporary files
- Logs rotation (compression and archiving of log files)
- Rebuilding system databases

Recommendations for use
Good to run every day: running maintenance scripts is fast and won’t compromise your Mac’s productivity.
Repair Disk Permissions

NOTE
This Maintenance task is not available in a trial version of CleanMyMac 3.

Every file and folder has a set of permissions that determines the types of actions you, system, applications, or other users can perform with it.

If permissions are getting corrupted due to, for example, improper system shutdown or incorrect changes made by the app during its installation, you may face some access- or performance-related issues.

CleanMyMac's Repair Disk Permissions task verifies current permissions and restores correct ones to ensure proper functioning of the Mac system and applications.

Recommendations for use
Run the task if either of these symptoms appear:

- Various access-related issues (for example, impossible to move, view, or delete files)
- Applications cannot function correctly (for example, icons are displayed in the Dock as question marks; some applications won't launch, etc.)

Verify Startup Disk

NOTE
This Maintenance task is not available in a trial version of CleanMyMac 3.
Also, note that Verify Startup Disk is currently not available in CleanMyMac 3.9.3 if your Mac has Apple File System and runs macOS 10.13+. We'll do our best to fix this issue as soon as possible.

The Verify Startup Disk task checks the file system on your main disk to make sure all data is solid and safe. If the disk needs repairs, CleanMyMac provides you with appropriate instructions on using Mac's Recovery HD functionality.

Recommendations for use
Run the task periodically as part of general Mac maintenance, or if either of these symptoms appear:

- A significant performance drop while reading or writing data
- Some files got corrupted
- Your Mac experiences difficulties while finding or using data
If you have disks, other than the startup drive on your Mac, you will be able to verify and repair them right within CleanMyMac 3.

**Speed Up Mail**

The Speed Up Mail task reindexes macOS Mail envelope index database to resolve widespread message content issues, improve performance, and search speed. Reindexing is a safe and useful procedure that doesn’t affect your emails.

**Recommendations for use**

Depending on your mailbox size, the completion of the Speed Up Mail task may take up to a couple of hours (for large mailboxes). To speed up the reindexing process, before proceeding with the task, we recommend you to do the following:

- Clean up Junk and Trash folders in Mail
- Delete unneeded emails

Run the task if either of these symptoms appear:

- Mail’s search works slowly and cannot find existing messages
- Impossible to delete, move, or receive messages
- Message content cannot be displayed properly

**Rebuild Launch Services Database**

The Finder uses the Launch Services database to keep information about file types and applications assigned to open them by default.

As you install, remove, or update applications, database may become corrupted and cause some troubles with opening applications or with displaying correct contents of the Open With menu (control-click any file and choose the Open With command). Use the Rebuild Launch Service Database task to resolve these issues.

**Recommendations for use**

Run the task if either of these symptoms appear:

- When you double-click a file, it opens in a wrong application
- Some files and folders have incorrect file type icons
- The Open With menu displays duplicated or outdated application references
Reindex Spotlight

**NOTE**
This Maintenance task is not available in a trial version of CleanMyMac 3.

The Reindex Spotlight task initiates a complete reindexing of your Mac’s main search engine to improve its performance and accuracy. Generally, Spotlight indexes itself automatically, but after working with a large number of files or after a long period of service it may need help.

**Recommendations for use**
Please mind that Spotlight reindexing is rather time- and resource-consuming procedure that will keep your Mac under a high workload until the task is completed. During this period, Spotlight won’t be available, but it will work perfectly for you afterwards.

Run the task if either of these symptoms appear:
- Overall search performance drop
- Spotlight does not find existing items

Flush DNS Cache

macOS keeps a local cache of resolved Domain Name System (DNS) requests during the period defined by the DNS server.

In some cases, you may need to reset the cache immediately and get new DNS records. For example, after an entry on the DNS server is changed, or a new entry is added.

**Recommendations for use**
Run the task if either of these symptoms appear:
- Inability to connect to some websites
- Random or permanent network slowdown

**Reset Maintenance task list:** If you want to update current Maintenance Task list, choose Action → Refresh. Note that your tasks selection won’t be saved.
Privacy

What can you do with this utility?
The Privacy module securely cleans up chat, browsing and download history, cookies, recent items list, and more to help keep online and offline activity on your Mac private.

When you click Select Items, CleanMyMac opens a main Privacy screen, where all data is sorted into groups depending on a type of activities or used applications.

Browsing and surfing on the Internet

All browser-related information is gathered in groups under appropriate names of the supported browsers:

- Safari
- Google Chrome
- Opera
- Mozilla Firefox

Each browser group generally contains the following items:

- **Autofill Values** — data kept by your browser to quickly fill in some fields with appropriate information.
- **Browsing History** — a list of web addresses you’ve opened with a browser.
- **Cookies** — small files sent to your computer when you visit a website. Cookies help you navigate websites and perform some functions, but they also keep certain private information regarding your activities, browsing preferences, and history.
- **Downloads History** — a list of all files downloaded via a particular browser. Note that Privacy does not remove files themselves; it only clears a name list of these files in a browser.
- **HTML5 Local Storage** — locally stored information similar to cache.
- **Saved Passwords** — a list of credentials you allowed a browser to remember and to fill in the appropriate fields.
- **Tabs from Last Session** — a list of windows and tabs that were open the last time you used the browser.

Instant messaging

You can remove your conversation, call and file transfer history related to the following messengers: Skype, Messages, AOL IM, Jabber, Yahoo, iMessage.
Viewing items on Mac

When you open a file with an application, it usually adds this file to its own list of recent items. Similarly, your Mac remembers all applications, documents and servers you’ve opened or viewed, and keeps references on them in the Recent Items menu of the main Apple menu. The Privacy module quickly erases all of these traces throughout the system. However, there’s no need to worry about the actual files and documents, they are not affected.

NOTE
You must quit all browsers so that Privacy could detect all items with your private information.

Review a list of activities that can be removed
After you open a main Privacy screen, you can do any of the following:

View files included to a group: Click a group. Items included to the group are revealed in the right-side pane. To view contents of a folder in the right-side pane, click its disclosure triangle.

View a file in the Finder: Hover over an item you want to reveal and click a magnifier icon next to it.

Change sorting of items: Choose an appropriate option from the “Sort by” pop-up menu.

Sort out items based on their creation time: Click the “Time range to clean” pop-up menu and choose one of the available options. After changing a time period, you’ll need to quit your browser due to estimation purposes.

Find an item within scan results: Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

NOTE
You will need to reenter some passwords (except for those stored in Key Chain) and set up preferences on some websites after removing private data.

Reset the Privacy list: If you want to update the current Privacy list, choose Action → Refresh. Note that your items selection won’t be saved.
Extensions

What can you do with this utility?
Apart from ordinary applications, there are a lot of other software components on your system, like extensions, widgets, and plugins. CleanMyMac’s Extensions module gathers all of them together and lets you remove or disable them at your convenience.

After you clicked View All Extensions, CleanMyMac opens a main Extensions module screen, which shows you all available extensions in groups:

Plugins  Many of your applications have additions (plugins) that expand their functionality. Plugins might be difficult to get rid of since they quite often do not have dedicated uninstallers. Depending on the parent application or its type, the Extensions module displays plugins in the corresponding groups and allows you to remove any plugin with a couple of clicks.

Widgets  CleanMyMac gathers all your small third-party Dashboard applications (widgets) so that you could easily disable or completely remove the unneeded ones.

Login Items  Manageable list of applications that are automatically launched every time you start your Mac.

Preference Panes  Your custom preference panes and their multiple support files are spread over the system. CleanMyMac simplifies locating and viewing these files.

Screen Savers  CleanMyMac allows you to remove an unnecessary screen saver correctly or disable it to make temporarily unavailable in System Preferences.

Dictionaries  Your macOS has multiple built-in dictionaries, most of which you won’t ever need. Remove them to save space or just disable temporarily.

Launch Agents  Some applications installed on your Mac come with small helper apps (launch agents). These apps broaden the functionality of the parent product, but in some cases you may consider removing or disabling them.
Services

Some applications install additional services onto your system. You can access these services via file shortcut menus right in the Finder. Use CleanMyMac to disable unnecessary services.

Siri

Siri is an intelligent personal assistant that can help you whenever you ask for it. However, if you prefer to keep your privacy on the highest level you might want to disable Siri. Note that Siri is a system application, that’s why removing it completely is impossible.

NOTE

Some extensions are marked with info signs and do not have checkboxes. These extensions can be removed only along with the associated applications or services. Yet, you can easily disable or enable these extensions.

Review available extensions

On the main Extensions screen, you can do the following:

View extensions included to a group: Click the group. Extensions included to the group are revealed in the right-side pane. To view contents of a folder in the right-side pane, click its disclosure triangle.

View an item in the Finder: Hover over an item you want to reveal and click a magnifier icon next to it.

Change sorting of items or groups: Choose appropriate options from “Sort by” pop-up menus to change sorting of extension groups and items.

Find an item within scan results: Start typing a word in the search field — results appear below the field right as you type. Click Close (x) to view all available items.

Reset the Extensions list: If you want to update the current Extensions list, choose Action → Refresh. Note that your items selection won't be saved.

Remove extensions

NOTE

By default, CleanMyMac does not offer any extensions for removal. If you decide to remove an item completely, you will not be able to undo this action.
However, if you disable an extension, it can be easily turned on.

1. Click the appropriate extensions group in the right-side pane.

2. Do any of the following:
   - Select a checkbox opposite an item you want to remove.
   - Click Select All at the top of the window to add all items of the group to removal list.

3. After selecting the items you want to delete, click Remove.

Disable extensions

Each extension has Enable or Disable status next to it. If you want to turn off an extension, hover over its Enable status. When it changes to Disable, click the status.

See also

- Smart Cleanup
- Uninstaller
Shredder

What can you do with this utility?
Shredder helps you easily remove any files you no longer need in either a secure or ordinary way. If you select secure removal, be sure that erased files, including their digital footprints, will be made completely irrecoverable. Shredder seamlessly deals with the task even when the Finder brings up errors while trying to remove items involved in current processes.

Add files to Shredder’s removal list
You can do any of the following:

- Click Select Files on Shredder’s start screen.
- Drag files or folders either directly to the CleanMyMac Dock icon or to the open CleanMyMac window.
- Click Add Files on Shredder’s main screen.

Erase files with Shredder
You can choose a removal option from the pop-up menu next to the Shred button:

- **Remove Immediately**: This is a default option and it removes files in an ordinary way from your disk.
- **Remove Securely**: This option deletes items so that they cannot be recovered with any special tools. This type of removal takes more time, but all data gets rewritten, which leaves no chance to recover.

**NOTE**
Despite the fact that the Secure Empty Trash feature is missing in macOS El Capitan (10.11 and higher), CleanMyMac still effectively removes your data in a secure way.

See also
- Smart Cleanup
- Large & Old Files
- Uninstalled
Dashboard

What is CleanMyMac Dashboard?
The Dashboard is a real-time status and monitoring panel of CleanMyMac 3 that shows infographics of your internal drives, random-access memory (RAM or memory), battery, and processor (CPU), as well as displays other useful information.

Each Mac component is displayed as a graph, which is a visual representation of the component containing a brief legend.

What can you do with the Dashboard?
- Get notifications about possible Mac health issues
- Improve your Mac's performance through RAM cleanup
- View an amount of available disk space, processor workload and current battery state
- Remind your Mac's model
- Check total amount of data removed with CleanMyMac

Open the Dashboard
The Dashboard button is available on any CleanMyMac screen in the upper right corner. Click the button to open the Dashboard.

Check the component's state
Hover over the graph to reveal its legend. It provides detailed information about the state of a component and reveals some valuable features:

**Battery**
The current charge level of the battery is displayed above the Battery graph.

You can take one of the following actions with this Dashboard element:

- **View details on the battery state**: Hover over the Battery graph to check its health and a number of charge cycles.
- **Open the battery preferences**: Click on the Battery icon to open Energy Saver Preferences (in System Preferences).
Hard drive graph

CleanMyMac monitors all internal volumes of your Mac and displays them individually with their own icons, names, and graphs.

Each graph contains color-encoded sections that represent different categories of files stored on a disk. The size of a sector correlates with the amount of disk space used by the corresponding file category. The exact size is specified in the legend.

A disk graph contains the following file categories:

- **Audio** — your iTunes library and files in MP3, AAC, AIFF, APE and other audio formats.
- **Movies** — video files, including movies and podcasts of all known video formats.
- **Photos** — your Photos library and files in JPEG, PNG, TIFF and other image formats.
- **Apps** — application files from any location on the drive.
- **Backups** — archives, containers and backup files of different origin.
- **Other** — all files that cannot be referred to any of the listed above file categories. For example, contacts, calendar data, the System folder, cache data, application plugins, and so on.
- **Used** — a single category that displays the amount of occupied space if for some reason categorization is not available.

The amount of available disk space is displayed right above the hard drive graph. It represents the total amount of both “free” and “purgeable” space that can be instantly released by the system. Learn more about purgeable space [here](#).

You can take one of the following actions with this Dashboard element:

- **View a disk in the Finder**: Click on a disk icon.
- **Open the Finder with the Spotlight search for a particular file category**: Double-click a corresponding section of the graph.
- **View a short file category description in the legend**: Click a category name.
Memory

RAM keeps the information that is being processed by your system and applications. Generally, it helps speed up completion of operations, but as the amount of data stored in the memory grows, your Mac may become slower.

As you hover over the Memory graph, you see the following data categories:

- **Wired** — information in RAM that can’t be moved to the drive or used by other applications. The amount of wired memory depends on the system configuration and applications you are using.
- **Active** — data that is currently being used and constantly addressed to.
- **Inactive** — information that was recently used but remains currently unaddressed.
- **Compressed** — the amount of memory used by inactive applications that was compressed to make more RAM available to active applications.

You can take one of the following actions with this Dashboard element:

- **Open Activity Monitor**: Click on the Memory icon to open Activity Monitor.
- **Clean up the memory**: Click Free Up. Be sure, this operation does not affect any of your files located on hard drives.

Processor

This Dashboard element shows the current CPU (processor) workload in %.

Open Activity Monitor: Click on the Processor icon to open Activity Monitor.

Manage Mac’s health issues

If CleanMyMac notices some issues that may affect Mac’s performance, it changes the Dashboard button title to warn you. For example, if CleanMyMac detects some serious system problem, you’ll see “1 critical issue” instead of the “Dashboard” title.
Review a health issue
Open the Dashboard and click on a yellow warning triangle that is located next to a component. CleanMyMac will show a pop-up message with a description of the health issue and applicable recommendations.

NOTE
The warning icon does not disappear from the Dashboard until the issue is resolved.
CleanMyMac 3 Menu

What is CleanMyMac 3 Menu?
CleanMyMac 3 Menu is a handy assistant that alerts you of Mac’s health issues and lets you perform many CleanMyMac 3 operations without launching the application itself.

The Menu icon 📑 appears in the Apple menu bar when you start CleanMyMac for the first time. And, when you close CleanMyMac, the Menu stays active and continues to notify you of important system changes.

What can you do with the Menu?
- Check startup disk, battery, memory and the Trash folder statuses
- Get notifications about possible Mac health issues
- Free up RAM
- Empty Trash
- Launch CleanMyMac 3

Review CleanMyMac 3 Menu
Click the CleanMyMac Menu status icon to access the Menu.

If the Menu is turned off, choose CleanMyMac 3 → Preferences → CleanMyMac 3 Menu tab.
Click on the switch to turn the Menu on.

CleanMyMac 3 Menu contains the following information:

- **Startup disk**: Available disk space, drive’s health, and the threshold for the minimum free disk space. Click on a disk icon to view it in Finder.
- **Memory (RAM)**: Amount of unused memory and total memory size. Open Activity Monitor by clicking on the Memory icon.
- **Battery**: Charge level, health, and total battery capacity. Open Energy Saver Preferences by clicking on the Battery icon.
- **System Trash folder**: The size of the system Trash folder, Trash folders on external drives and the threshold for their maximum volume. Open the Trash folder by clicking on the Trash icon.
Receive CleanMyMac 3 Menu notifications
The Menu shows you the following important notifications (the corresponding pop-up messages appear occasionally):

- Alerts about a little amount of free space on your disk
- Notifications about exceeding the preset threshold for the system trash
- Suggestions on correct uninstallation of trashed applications (displayed when you try moving an application to the Trash folder)
- Disk failure precautions based on internal drive diagnostics
- Warnings about possible disk overheating
- Battery failure alerts
- Heavy memory usage alerts
- Notifications about non-responding applications

Apart from warnings and alerts, CleanMyMac uses its notifications to give you advice on resolving the revealed issue. You may decide to ignore or postpone a notification.

Free up RAM
Open the CleanMyMac Menu, hover over the Memory area, and then click Free Up.

Empty the Trash folders
Open the CleanMyMac Menu, hover over the Trash area, and then click Empty Trash.

Modify CleanMyMac 3 Menu settings
You can change the Menu settings on the CleanMyMac 3 Menu tab of CleanMyMac Preferences. To learn more about, see CleanMyMac 3 Menu Tab.
Turn off CleanMyMac 3 Menu

Close CleanMyMac 3 Menu until the next launch of CleanMyMac 3: Click the gear icon in the bottom right corner of the CleanMyMac 3 Menu, and then choose Quit.

Disable CleanMyMac 3 Menu: Choose CleanMyMac 3 → Preferences, and then switch to the CleanMyMac 3 Menu tab. Click on the switch to turn the Menu off. CleanMyMac 3 Menu won’t be launched during further CleanMyMac sessions unless you change the preferences.

NOTE

Please also note that if you decide to turn off CleanMyMac 3 Menu, you may overlook an important warning or health issue. CleanMyMac 3 sends you most of its notifications through the Menu.

However, you can set the Scheduler to regularly remind you about the cleanup necessity. In this case, CleanMyMac will notify you about this event even if the Menu is off. To learn more about the Scheduler, see Scheduler Tab.
Preferences

You can make CleanMyMac 3 work exactly as you expect by customizing its preferences.

Open CleanMyMac 3 Preferences

Do any of the following:

Choose CleanMyMac 3 → Preferences.
Open CleanMyMac 3 Menu, click the gear icon, and then choose Preferences from the pop-up menu.
Press Command-Comma (⌘-,).

The Preferences window contains the following configuration tabs:

- General
- Smart Cleanup
- Scheduler
- CleanMyMac 3 Menu
- Updates
- Privacy
- Ignore List

General Tab

The first tab you see when you open CleanMyMac Preferences is the General tab where you can configure language Ignore List and reset all warnings received from CleanMyMac 3:
Add more languages to CleanMyMac’s Ignore List
If you want to add more languages to CleanMyMac’s ignore list, first, you need to add these languages in System Preferences and restart your CleanMyMac.

Then, click Add (+) on the General tab of CleanMyMac Preferences. This reveals a dialog with a list of languages previously selected in the Language & Region macOS preferences. Choose the languages you want to add to the Ignore List.

Smart Cleanup Tab
When you start Smart Cleanup scanning, CleanMyMac goes through all of its cleaning modules by default. However, you may want to exclude some modules or submodules from the scanning process (to speed up scanning, for example). Do it on the Smart Cleanup tab.

Exclude a module or submodule from a scan list: Deselect the checkbox next to the appropriate submodule/module.

Note that if you exclude some System Junk or iTunes Junk submodules from the scan list, they are also ignored during a separate scan in System Junk or iTunes Junk, relatively.

For example, if you deselect the User Cache Files submodule of System Junk, this submodule is ignored during the scan in both System Junk and Smart Cleanup.

However, if you deselect a checkbox of System Junk or iTunes Junk (including all their submodules), the corresponding module is ignored by Smart Cleanup, but fully scanned when you start it separately.

**NOTE**
Deselecting a module does not remove it from CleanMyMac. You can change the preferences whenever you want to.

Scheduler Tab
If you’d like to receive reminders about regular cleanup procedures, you can set the Scheduler:
CleanMyMac 3 Menu Tab

The CleanMyMac 3 Menu tab allows you to enable CleanMyMac 3 Menu and configure notification rules for hung applications, Trash folder, uninstalled apps, and others:

![CleanMyMac 3 Menu Tab](image)

- Set the maximum allowed amount of files in the Trash.
- Set the minimum free space threshold for the startup drive.
- Select the checkbox if you want to get help when some application stops responding.
- Select to get reminders about complete app uninstallation when you drop it to the Trash.
- Click to reset all health and monitoring notifications from CleanMyMac 3 Menu.
- Click on the switch to turn the Menu off.

Updates Tab

You can change CleanMyMac’s update preferences and apply for our beta-testing program on the Updates tab:

![Updates Tab](image)

- Deselect the checkbox to stop tracking availability of updates.
- Deselect the checkbox to prevent automatic updates.
- Select the checkbox to test CleanMyMac beta versions.
- Deselect the checkbox to stop updating the Safety Database.
- Click to check the availability of CleanMyMac updates.
Privacy Tab

The Privacy tab allows you to change logging and anonymous usage reporting preferences:

![Privacy tab settings](image)

Ignore List Tab

What is CleanMyMac Ignore List?

CleanMyMac’s Ignore List contains files and folders you have preferred not to be revealed in scan results. These items can be added from the following modules: System Junk, Photo Junk, Mail Attachments, iTunes Junk, Trash Bins, Large & Old Files, and Uninstaller.

How to add files and folders to the Ignore List?

**On the module’s detailed results screen:** Navigate to a detailed results screen of a module, control-click an appropriate file and choose Add to Ignore List from the shortcut menu.

**On the Ignore List tab of CleanMyMac Preferences:** Click the appropriate module on the Ignore List tab, and then click Add (+). Navigate to items you want to exclude from CleanMyMac scan results and click Add. Using this method, you can add items of the following modules: System Junk, Trash Bins, Large & Old Files, and Uninstaller.
You can view and manage items earlier excluded from scan results as well as add new items that will be ignored in future scan results:

Add specific item types to the Ignore List

Add all RAW files (not supported on macOS 10.13 and later): Switch to the Photo Junk section and select “Ignore RAW photos” checkbox. This feature excludes RAW files from Photo Junk scan results.
Add drive’s trash folder or photo libraries: Switch to the Trash Bins section, click Add (+) and choose the Add Volume or Add Photos Library option from the pop-up menu. Then, navigate to the item you want to be ignored in the Trash Bins module and click Add.

Add files by their extensions (for Large & Old Files only): Switch to the Large & Old Files section and click Add (+) in the “File extensions to ignore” field. Then, choose any file with the extension you want to exclude from the scan results. Alternatively, enter extensions manually in the corresponding field.

Add all system applications: Switch to Uninstaller section and select the Ignore system application checkbox (it is selected by default).

NOTE
All changes made to the Ignore List preferences take effect after a new scan.